
Chapter 1

Overview of MillWrite

Use ALL mouse buttons

You don’t have to move the mouse as often in MillWrite as
in other Window’s programs because MillWrite uses the RIGHT

mouse button to access menus, to cancel menus, and to cancel
other operations.

For example, normally when you are inside a menu and
you decide you want to get out of it, you have to move the

mouse outside of it, or you have to move the mouse to a
CANCEL button and then click that button. But with MillWrite
you only have to click the right mouse button. Depending on
which menu you are in, and what you are in the middle of
doing, either the menu will be closed, or the mouse will
automatically move to the CANCEL button for you. (You can
also press the k key to cancel menus)

Right button: the NEW ITEM menu

When you are at the Drawing page and the mouse is not
touching anything in the drawing, you can click the right
mouse button for the New Item menu (seen below). After the
menu appears, click the left mouse button on whichever of
those functions you want to set the left button to. You can set
the function of the middle button by clicking the middle button
on one of the functions.

For example, if you want to draw circles, click the left
mouse button on the Draw Circle function. The menu will
disappear and the left mouse button will be set to draw circles.

When you are finished drawing circles, click the right
button again and select something else from the New Item
menu. If you are finished drawing and want the left mouse
button to return to its default condition, select the arrow in the
upper left corner of the menu.

Right button: the NODE menu

When you are at the Drawing page you can access the
geometry editing functions by touching any item in the
drawing with the mouse and clicking the right mouse button.
The Node Menu will then pop up, as seen below. You can
then set the left mouse button to one of the geometry editing
functions by clicking the left button on whichever function you
want. You can also set the function of the middle button by
clicking the middle button on one of the functions. If you
decide to cancel the menu without doing anything, just click
the right mouse button.
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The Draw Menu

The New Item menu (page 1) lets you draw freehand with
the mouse. The Draw Menu on the Drawing page (Figure 1-1)
lets you draw by specifing XY coordinates and other values.
These steps show how to draw a circle:

Step 1) Bring up the Draw menu.

Either click the Draw button at the upper left of
the screen, or press D, which represents the D in
Draw. The Draw menu will appear.

Step 2) Select the option to draw a circle.

A column of buttons will appear on the right side
of the screen (Figure 1-2).

Step 3) Enter whatever values you know.

Assume you want a 3 inch diameter circle with its
center at X0,Y0. Click on either the Center label,
or on the recessed, data entry box to the right of
that label. Then type the digit 0.

You could then press the n key to let MillWrite
know you are finished entering digits into this
field, and then you could press the DOWN arrow
key (ie, …) to move to the field below.

However, you will avoid a keypress if instead you
press only the DOWN arrow key. MillWrite lets
you terminate a data entry and move up or down
to the next or previous field. So pressing the
DOWN key will put the cursor on Y Only field.
Type a 0 here, and then press the DOWN arrow
key. This puts the cursor on the Radius field. Type
1.5 and press n. You will now see a red,

dashed outline of a circle, with its center on
X0,Y0.

Step 4) Accept the circle.

The circle is shown in a red dashed line to
because it is temporary rather than part of the
drawing. While it is in this temporary condition
you can alter the center point and/or the diameter.
When you finished altering the circle, click the OK
button. The dashed circle then becomes a solid
circle. You now have a three inch circle in the
center of the drawing.

Step 5) Terminate the circle drawing function.

You could create another cirlce by filling in the
fields again. When you are finished creating
circles, terminate by clicking the OK button, the
Cancel button, or by pressing the k key.
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Terminology

Nodes

A node is an end point of a line or arc, or a control point of
a spline. Nodes have X-Y coordinates.

When a line or arc is an independent item, it has two
nodes. One node is the start node, and the other is the end
node. When you touch the mouse to an item, MillWrite
identifies the start node with a large circle, and the end node
with a small circle.

Polylines

MillWrite allows lines, arcs, and splines to be joined
together into polylines, which are similar to AutoCAD’s
polylines. When two lines are joined into a polyline, they share
a node at their junction. For example, a polyline that consists of
two lines will have three nodes. One node is the start node,
one is the end node, and the middle node is just a node.

Links

A polyline is like a chain, and the lines, arcs, and splines that
make up the polyline are similar to the links of the chain.
MillWrite refers to the geometry between two nodes as a link.
A link may be a line, an arc, or a section of a spline.

Tangent and Loose nodes

The nodes that connect two links together may be set as
tangent or loose. A loose node allows the adjacent links to
swivel with no regard to the position of the other. Some CAD
systems refer to such nodes as “cusps”. If you set a node to be
tangent, then MillWrite will maintain the tangency between the
links as you move or alter the polyline.

The image below shows a polyline that consists of three arcs
and one line. It has a total of five nodes and four links. At the
junction between the first two arcs is a tangent node. The next
two junctions are loose nodes. MillWrite shows the tangent
nodes as squares, and the loose nodes as circles.

Snap

The word “Snap” is used to describe functions that cause
the mouse to jump to an XY location. There are three different
snap categories. A brief overview of them will be found at the
pages in parenthesis.

w Snap to nodes and links (page 7)

w Object Snap (page 8)

w Snap to Grid (page 5)

Hi-liting items

MillWrite hi-lites items (ie, highlights) to show you which
item you are currently working with. The next page explains
this.

Flexible and Rigid lines

Lines can be designated as flexible or rigid. When you set
a line as rigid, you are informing MillWrite that you don’t want
it to become an arc. If you try to “flex” it into an arc using the
Flex Link function, MillWrite will display a warning that the
line is rigid and offer you the option to convert it to a flexible
line. Therefore, by designating lines as rigid you can avoid
accidentally changing them to arcs.

Flexing Lines, Rectangles, and Text

As the previous paragraph mentioned, you can use the
Flex Link function to flex a line into an arc. MillWrite also lets
you flex rectangles and text.

Text has a box around it, and the box has four links. A
rectangle also has four links. In both cases, two of the four
links are set as rigid lines and two are set as flexible. You can
use the Flex Link function to flex the rectangle and the text.
Below are some before and after images to show what
happens when you flex text and rectangles. If the flex function
refuses to flex the rectangle, you have the mouse on the rigid
links; move the mouse to its adjacent link.
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Put mouse over an item to Hi-Lite it

Most CAD and CAM systems require you to first click an
item before you can edit it. With MillWrite, all you do is move
the mouse over it. Whatever item the mouse is touching
becomes “hi-lited”.

How do you know when something is hi-lited?

When an arc is hi-lited, MillWrite
draws two lines from the center point
to each of the two nodes at the end of
the arc, as seen in the image to the
right. This shows you where the center
point of the arc is.

When something other than an arc
is selected, MillWrite puts circles (or
squares) at the nodes. This “hi-lites” the
nodes so that you can see where they
are. In the image to the right, the line is
selected.

Parameters appear when an item is hi-lited

When you touch the mouse to something in the drawing,
the parameters for it appear along the right side of the screen
(Figure 1-3). You can edit any of the parameters by sliding the
mouse over to that area and clicking the left button. Or, when
the mouse is touching the item, you can press the E key and
MillWrite will move the mouse to the parameters area for you.
(Look at the lower right corner of the screen for messages to
remind you of such commands as the E key. The E in the word
Edit along the bottom of th screen is a different color, indicating
that it is a hotkey.)

In either case, once the cursor bar is in the parameters area
you can change the shape of the item or change its usage. The
usage field is where you specify whether you want the item in
grade and, pocketed, contoured, or if it’s just a drawing aid that
will never be machined.

You can turn on or off the showing of the parameters when
you touch an item. Normally you leave it on, but when you
want to see more details in your drawing you can turn it off.
When you turn off this option, the right portion of the screen
will be used for the drawing. In such a case you have to press
the E key to edit the parameters. The option to turn off the
parameters is in the Show button menu.
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Show all nodes / Show only hi-lited link e

You have the option of setting MillWrite to show every
node in an item when it is hi-lited, or show only the link the
mouse is touching. When all nodes are showing, you can
easily see which nodes belong to the item. Press the e key to
change between these two different modes. The two images to
the left show the difference between showing all nodes and
showing only the link at the mouse.

When an item has a lot of nodes, it may be easier to see
the drawing when you turn off the showing of all nodes.

If MillWrite Hi-Lites the wrong item z / ‘

When your drawing has items on top of each other, or
touching each other, MillWrite will sometimes hi-lite the
wrong item when you try to edit one of them. The solution is
to press either the spacebar or the tab key until the item you
want has been hi-lited.

For example, in the images below, the mouse is at a
location where it is on top of two different arcs. MillWrite has
to make a decision about which arc to hi-lite in such a case,
but MillWrite may not choose the arc you want.

When MillWrite makes the wrong decision on which arc
you are trying to hi-lite, just press the z or ‘ key to force
MillWrite to hi-lite the next item it finds at that location. The
image to the bottom right shows what happens after pressing
z or ‘. The mouse is at the same location, but MillWrite
has hi-lited the start node of a different arc of a different
polyline.
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Keyboard usage

Shortcuts for Menu Functions

The keyboard shortcuts are listed along the right edge of the
menus in a different color. For example, in the Edit Menu (a
portion is show below), the O key is the keyboard command for
the Offset function, and F is the shortcut for the Fillet function.
Therefore, rather than click on the Edit menu for those
functions, you can just press O for the Offset function, or F for
the Fillet function.

If you see the caret (ie, ^) in a menu, that represents the
CTRL key, so ^S represents xS, and ^Z is xZ.

Snap to Grid i

As with AutoCAD, you can turn on and off an imaginary
grid with the i key. When the grid is on, the mouse will jump
from one grid point to the next. For example, if you set the grid
to 0.5 inch, then the mouse will move in increments of 0.5
inch.

There is a button on the drawing page that shows whether
the grid is on or off, and if it is on, the button shows the value of
the grid (see image at the bottom of this page). The letter G in
the button represents the word Grid. In the image at the bottom
of this page the grid is on it and it has a value of 0.001. When
the grid is off you will see the word OFF in the button.

Ortho mode h

The ortho mode lets you restrict movement to only
horizontal, or only vertical. For example, if you set the ortho
mode to vertical only, then when you drag nodes or draw lines,
they will only move up or down; they will not be able to move
side to side. This allows you to move an object upwards or
downwards without worrying about it slipping left or right.

Ortho mode has three states. Each time you press h (or
click the ortho button) the ortho mode changes to its next state.
The three states are:

w Off (as seen in the image at bottom of page)

w Restrict movement to horizontal

w Restrict movement to vertical

Crosshairs ~

You can turn the crosshairs on and off with the ~ key. (This
is not the key with the quotation marks; rather, it is the key with
a tilde and a backwards accent mark.)

The crosshairs is useful when you want to see how items
line up horizontally or vertically. The two images below show
the same drawing with and without the crosshairs.

Zooming and panning with the Keyboard

r, s Zoom in, Zoom out

T Pan, up

v u Pan, left and right

… Pan, down

Q The point you click with the mouse becomes center
of the screen. You can then zoom in and out without
that location changing.

Z Zooms in (or out) to show the hi-lited link.

G Go to XY Coordinate. Shifts the view of the drawing
to the X-Y coordinate you specify. For example, to see
the area around an X-Y coordinate of X3.45 Y-12.7,
press G and then type the numbers. You do not need
to type the letters X or Y. Separate the values with
spaces or a comma. MillWrite will then put X3.45
Y-12.7 in the center of the screen, and you can press
r or s to zoom in or out without moving the
center of the screen from X3.45 Y-12.7
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Snapping to nodes and links c

MillWrite uses the word snap in a few different ways. For
example, you can snap to grid, as mentioned on page 6. You
can also snap to nodes or links. To understand this feature,
consider the images to the left. In the first image a line is being
drawn towards the state of Virginia. As the mouse gets near the
geometry that makes up the states, MillWrite snaps the end of
the line to one of the nodes. MillWrite is making the
assumption that you want to draw the line to one of those
nodes. However, if you don’t want to do that, you must turn
off the snap to node feature by pressing the c key. When it is
off, the mouse can move anywhere without MillWrite hi-liting
nodes, as seen in the bottom image. Press the c key at
anytime to turn this feature on and off.

Restrict snapping with CTRL and SHIFT

Whenever you draw lines or move nodes, you can hold
the x key down to restrict movement to only vertical or only
horizontal. If the snap to node feature is also turned on, then
when you touch an object MillWrite will snap to it while at the
same time restricting movement to vertical or horizontal.

If you hold both the x and one of the shift keys (ie, y)
down, MillWrite will restrict movement to 45° angles,
specifically, 45°, 135°, 225°, 315°. The images below illustrate
this.
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Example of Object Snap

Figure 1-4 shows a line at a 100° angle as measured from
the bottom of the line. Figure 1-5 shows the same line except
that the top .25 inch of the line has been replaced with a
tangent arc that has a .25 inch radius. This example will show
how to change the line in Figure 1-4 into the line and arc in
Figure 1-5 in order to provide an overview of the Object Snap
features.

Figure 1-6 shows what you know about the arc and line.
The arc has a .25 radius and sweep of 90°. You also know that
the start of the arc is .25 inches from the end of the line. You
could calculate where the center point of the arc is, and what
the coordinates are for the start and end of the arc, but the
Object Snap functions provide a way to create the arc without
doing any calculations.

To create the line, bring up the Draw menu by clicking the
Draw button at the upper left corner of the screen, or just press
the D key. Then select the Line function. The process is similar
to the circle example on page 2. As with circles, you fill in only
the fields you know; ie, you don’t have to fill in all fields. So
enter a length, such as 1.4, and set the angle to 100°. The line is
complete, so click OK, and then cancel the drawing function.

To draw the arc, bring up the Draw menu and select the
Arc function. The screen will change as seen in Figure 1-7.

You know that the start point of the arc is .25 inches from
the end of the line, so begin by specifying the start point of this
arc. Click the left mouse button on the start label (as seen in
Figure 1-7). The label will begin blinking in blue and a message
on the bottom right corner of the screen will remind you that
you can click the right mouse button for the object snap
functions. So click the right mouse button on the label start. (If
you had known that you could do this with the right button,
you could have clicked only the right button, ie, you do not
have to click the left button first, and then the right).

The Object Snap menu will pop up in the middle of the
screen (Figure 1-8). Since you know that the start point of the
arc is at a certain distance from the end point of the line, select
the At A Distance option.
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The screen will change as seen in Figure 1-9. At the top of
the screen is a data entry field where you can specify the
distance and angle. The distance and angle is from a reference
point. Therefore, you must specify both a reference point and
a distance and angle from that reference point.

The reference point in this situation is the upper end of
line. If you forget how to set the reference point, at the top of

the screen is a prompt to remind you that you set the
reference point with the mouse. Put the left mouse button on
the end of the line, as seen in Figure 1-9, and click the left
button. At the top of the screen the coordinates for the
reference point will change to whatever they are for the end of
that line.

If you click the wrong point, just click until you get the right
one. MillWrite will not do anything until you press the n

key, so it doesn't matter if you make a mistake when you pick
the reference point.

You must also specify the distance and angle from that
reference point. The distance is .25 inches, but what is the
angle? Referring to Figure 1-6, the line has an angle of 100° as
measured from the bottom of the line. However, the start
point for the arc is being measured from the top of the line,
and from the top of the line the angle of the line is 280°.
Therefore, the distance and angle you specify is .25 inch at an
angle of 280°.

How to specify distances and angles

Specify the distance first followed by the angle. Between
the two values type either > or <. Therefore, to enter a
distance of 0.25 inches at 280°, type .25<280

To enter the distance and angle, just start typing. You do
not have to first click the data entry box. Actually, if you try to
click the box you will find the mouse doesn't even move to it.

As you type the values .25<280, MillWrite will put an X at
the resulting point to show you the location you are specifying
(see Figure 1-9).

It is important to realize that it doesn't matter if you specify
the distance and angle first and then click on the reference
point, or if you click on the reference point first and then
specify the distance and angle. Nothing happens until you
press the n key, so you can change the reference point
and/or the distance and angle as many times as you want.

Also, if you knew the length of this line then you could
have used the lower end of the line as the reference point
instead of the upper end. For example, if you knew that this
line was 1 inch long, then the arc would start .75 inches from
the bottom of the line. You could set the bottom of the line as
the reference point, and for the distance and angle you would
enter .75<100. The result would be the same point in either
case.

After you specify the distance, angle, and reference point,
press the n key. This sets the start point. You will see the
coordinates displayed in Start field.

Now move the cursor down to the Radius field. Enter .25
and press the down arrow key. This puts the cursor on the
Sweep field. Enter 90, and press the down arrow key.

You just specified enough info to create an arc, so
MillWrite will draw an arc, as seen in Figure 1-10. However,
this arc is incorrect because MillWrite is assuming it has a start
angle of zero degrees since you haven't specified the start
angle. If you zoom in to get a better view of the arc, you will
find that the arc is not tangent when it has a start angle of zero
degrees. In the angle field you must enter 10. (See Figure 1-6
to understand where the 10° comes from; the start angle of an
arc is measured from the center of the arc.)
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Figure 1-11 shows the result. This arc is now complete so
click the OK button. MillWrite will draw the arc in a solid line.
You're done with the arc drawing function, so click the OK

button, or the CANCEL button, or just press the k key.
Now all you have to do to complete this job is to chop off

.25 inches from the end of the line. There are several ways to
do this. For example, you could trim the line at the arc. Or you
could break the line at the start of the arc and then delete the
quarter inch piece from the end. The easiest method is to drag
the end of the line to the start of the arc.

Start by putting the mouse on the end node of the line. As
seen in Figure 1-12, the mouse icon should change to show the
words Move Node. If you find that the mouse has something
else, such as Draw Circle, or Slide Node, click the right mouse
button for the Node Menu. Then select the Move Node
function from that menu.

Click the left mouse button and start moving the mouse. As
seen in Figure 1-13, the line becomes dotted, and as you move
the mouse, you move the end node of the line.

Move the mouse to the start of the arc. When you touch the
start node of the arc, the mouse icon will change to show the
words Start Node, as seen in Figure 1-14. Also, you will see
both nodes of the arc become hi-lited, and two dotted lines will
be drawn from the center of the arc to the nodes of the arc.
MillWrite is showing you that the mouse has touched this arc.
This requires you have the snap to node function turned on
(the c key; see page 7). Click the left mouse button to
terminate the drag function. You have completed this job.

Note: If you do not have the snap to node function
on when you drag nodes, you cannot be guaranteed
that the ends of the lines and arcs have the exact
same X Y coordinates. Rather, the lines and arcs in
your drawing will appear to be touching each other,
but in reality there will be tiny gaps between them. So
make sure that the snap to node function is on when
you drag nodes. Press the c key to toggle the snap to
node feature on and off.
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Selecting items

MillWrite lets you select one or more items for more
complex editing operations. There are two ways to select
item(s):

1) Press and hold a SHIFT key (ie, y) and then click
an item you want to select. MillWrite will selecct that
item and switch to its Selection Mode. You can
release the y key and select more items by
clicking on them or by drawing a selection window
around them.

2) Draw a selection window. To do this, move the
mouse to an empty area of the drawing. When the
mouse is a plain arrow (as in Figure 1-15) you can
click the mouse and draw a window around the
items you want to select ( Figure 1-16). This causes
MillWrite to switch to its Selection Mode, even if
you don’t select anything.

Note: if the mouse icon shows words, such as DRAW
LINES (see the three images at top of page), click the
right mouse button for the New Item menu and
select the plain arrow in the upper left of the menu
(see bottom of page 1 for the New Item menu).
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The Selection Screen

Figure 1-17 shows the selection screen. At the top of the
screen you can see that eight items have been selected, and the
selected items are drawn in dotted lines.

When the mouse is not touching anything, it shows a
smaller mouse drawing a box, which is suppose to remind you
that if you click the mouse button, you will draw a box that will
select or un-select items. If you click the left button, you draw a
box that selects items, but if you click the right mouse button
you draw a box that un-selects items.

The Geometry Clipboard

You can copy and/or add selected items to the geometry
clipboard. If you click the Add button, you add selected items
to whatever items are already in the clipboard. If you click the
Cut button, MillWrite will clear the geometry clipboard, delete
the items from the drawing, and move the items into the
clipboard. In figure 1-17 the clipboard is empty, as you can see
by the message underneath the Add and Cut buttons. If you put
something into the clipboard, this message changes to show you
the number of items in the clipboard. You will also have the
option to empty the clipboard, which deletes whatever is in the
clipboard.
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Importing AutoCAD DXF files

You can import a DXF file for two different purposes. One is
to import the file for machining or editing. The other is to
import the file to use as a template.

Importing DXF files for machining or editing

From the File menu select the Import/Export option, and
then select the option to Import A DXF File. This brings up the
data entry screen seen in Figure 1-18. The first two fields should
be easy to understand, but the other fields need an explanation.

CAM operation

This is where you select the CAM operation for all items in
the DXF file. In Figure 1-18 the CAM operation is set to Cut
Centerline. This is what you would set it for if you want to
engrave the DXF file. If you do not want to machine any of it,
then you could set the CAM operation to Drawing Aids.

If the DXF file consists of a mixture of drawing aids,
engravings, and boundaries that you want to pocket or contour,
you have to select one of those CAM operations and then
manually change the items that need some other CAM
operation.

Join items together?

A DXF file may have hundreds of lines and arcs, many of
which are touching each other end to end in a continuous path.
But the CAD system that created the DXF file may not export
those continuous paths as polylines. Instead, the drawing may

consist of hundreds of individual lines and arcs scattered about
haphazardly.

If you set this field to YES, MillWrite will analyze the
geometry in the DXF file and connect all lines and arcs that are
touching each other end to end. The only time this may cause
problems is if you want to pocket or contour the items and if
there are lines and arcs on top of each other. In that case
MillWrite will create polylines that have segments on top of
each other. The lines and arcs that cross each other or are on
top of each other may interfere with the pocketing.

Ignore gaps up to

If a drawing is made properly, there will not be any gaps
between the lines and arcs that are suppose to be touching
end to end. But in reality there are often tiny gaps between
lines. This field let's you compensate for gaps. If MillWrite finds
a gap between two items that is less than whatever value you
enter here, MillWrite will join the two items together. For
example, in Figure 1-18 the gap is 0.0002 inches. If two lines
are within 0.0002 inches of touching each other, MillWrite will
join them together. (This field is available only if you set the
Join Items Together field to YES.)

Reorder afterwards?

The geometry in a DXF file is usually created in a
haphazard manner. If you were to engrave the geometry in the
same order that the DXF file has the geometry listed, then the
machine would waste a lot of time making rapid moves.

If you set the Reorder Afterwards field to YES, MillWrite
will analyze the items in the DXF file and reorder them so that
they are machined in a manner that reduces the quantity and
length of the rapid moves.

Figures 1-19 and 1-20 show how these fields can affect an
NC program. In Figure 1-19 a company logo was imported
with both the Reorder Afterwards field and the Join Items
Together field set to NO. There was a total of 139 items (ie,
139 lines and arcs) in that DXF file, most of which were
scattered haphazardly. MillWrite engraved the logo in exactly
the order the DXF file specified them, and the result was rapid
moves all over the place. (The rapid moves are the dotted
lines.)

Then the same DXF file was imported with the Reorder
Afterwards field set to YES. When MillWrite created an NC
program, there were fewer rapid moves, and the rapid moves
were shorter (Figure 1-20).
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Layer for all items

If you are importing the DXF file into a drawing that already
has several layers, and if you want to keep the geometry in this
DXF file separate from the rest of the drawing, you could
specify a layer for the entire DXF file. For example, you could
put the entire DXF file on layer 52. If you leave this field blank,
then whatever layers are in the DXF file will be retained when
you import the file. The only problem with trying to retain the
original layers of the DXF file is that CAD systems create layers
in a different manner, so MillWrite may interpret the layers
incorrectly.

Importing DXF files for templates

From the File menu select the Import/Export option, and
then Select a DXF File as a Template.

When you import a DXF file as a template, MillWrite
assumes you only want to look at the DXF file rather than
machine it or edit it. As an example of why you would want to
import a DXF file for a template, consider the panel in Figure
1-21. Assume you have to engrave the text and rounded
rectangles to identify all those switches and knobs. One way to
do this is to analyze the blueprint and then figure out the X and
Y coordinates for all the text and rounded rectangles. But an
easier method is to import a drawing of the switches and knobs
(Figure 1-22) and use it as a template. Then you could put the
text and rectangles in their proper positions visually.

A template provides visual verification that you have
everything in the proper position. And since the template is not
editable, you will not be bothered with the mouse accidentally
selecting items in the template.

Since MillWrite can export DXF files, you could create a
drawing in MillWrite, then export it as a DXF file, and then
import it as a template; ie, you can make templates for yourself.

14

Figure 1-21

Figure 1-22

Starting with this one

switch, make this array

of three switches



Creating Arrays of Items

Assume you want to create the template file seen in Figure
1-22, and so far you have drawn one of the switches, as seen
in Figure 1-23 (a close-up of that area). This example will
create an array of three switches from that one switch.

Set X0.0, Y0.0

The first thing to do before trying to make an array is to set
X0.0, Y0.0 to a suitable location. Since this panel is rectangular,
and since the dimensions are measured from the left and top
edges, it will be easiest to make the upper left corner X0 Y0.
The easiest way to do that is to bring up the Main Menu by
clicking the Menu button at the upper left corner of the screen
(or by pressing the k key). Then, from the Main Menu, select
the option to Move XY Location, and then select the option to
put X0 Y0 at the upper left corner.

Select the items to make an array of

To make an array of that switch you first select all the
geometry in it. As was described on page 11 in regards to
selecting items, draw a window around the switch. As soon as
you start to draw the selection window, MillWrite changes the
prompts at the top and bottom of the screen to let you realize
that you’re starting the selection mode. (see Figure 1-23).

After you’ve finished drawing the selection window the
screen changes to that of Figure 1-24. If you didn't select all the
geometry in the switch you could draw another window
around the items you missed. Or, if you selected items that
you were not suppose to select, you could unselect them
either by clicking the right mouse button on each of them, or
by drawing a window around them with the right mouse
button.

After you select all the geometry in the switch, click the
Array button (Figure 1-24), or press A which is the hotkey for
the Array function (the A in Array is a different color, indicating
it is a hotkey).

MillWrite will change the prompts on the screen and
provide data entry fields along the right side for you to specify
the array. As with the Draw functions, you fill in only the fields
that you know; i.e., you don’t have to fill in every field.

There is one row and three columns of switches, so enter 3
for the number of columns. Figure 1-21 shows that the
switches are separated from each other by 0.7 inches, so move
the cursor down to the Column Spacing field enter .7. This
gives MillWrite enough information to create an array and it
will draw three columns of the switch as seen in Figure 1-25.

However, MillWrite is defaulting to putting the array on
top of the original switch, but the array needs to be moved
down and to the right. So now you need to change the starting
position of the array.

At the top of the data entry fields is a field labeled Start.
The default for MillWrite is to set this to the center of whatever
you're making an array of. That is why this array of three
switches starts on top of the original switch.

According to the dimensions of Figure 1-21, the first of
these three buttons starts 2.1 inches below the top of the
panel, and 7.7 in. from the left edge of the panel. Since the
upper left corner of the panel has been set to X0.0, Y0.0, that
means the first of those three buttons is centered on a
coordinate of X7.7, Y-2.1. So enter those coordinates into the
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start data field. MillWrite will then change the position of the
array, as seen in Figure 1-26.

Notice in Figure 1-26 that MillWrite put a small dot at each
of the array locations. The significance of those array locations
will be seen later. For now notice that each switch is centered
on one of the array locations.

The array is now finished. However, look near the bottom
of the data fields of Figure 1-26. There is a check box where
you can select whether you want to delete the original item that
you're making an array of. In this particular case you do not
want to delete that original switch, so take the check mark off
by clicking on it.

You can now click the OK button. The array function will
terminate and you return to the Selection Mode. As seen in
Figure 1-27, the original switch has been un-selected, and the
three switches that you just created have been selected, giving a
total of 33 selected items.

The Duplicate function

The drawing in Figure 1-21 shows that next to these three
switches are three more switches. We could use the Array
function to create these three other switches. But this time let's
use the Duplicate function so you can see how that function
works. Besides, if you have to make only one copy of
something, it is easier to use the Duplicate function rather than
the Array function.

Click the Duplicate button (or press D, which is the
hotkey). Whenever you copy or move items, MillWrite will put
up a menu with two choices (Figure 1-27) and ask if you want
to drag the items or specify distances or angles. For this
example, it is best to select the option to specify distances
because we know exactly how far we want to place the
duplicates from the orginals.

The screen will change, as seen in figure 1-28. Along the
right side of the screen are data entry fields that let you specify
where to place the duplicates. You do not put values in all of
these data fields; rather, you put values only in the fields you
know. There are three different ways to specify the destination:

1) Specify a From point and a To point

If there are two points in your drawings that are the exact
distance and angle from each other that you want the
duplicates to be separated from their originals, you could select
those two points. MillWrite would then calculate the distance
and angle between those points, and then position the
duplicates at that same distance and angle. You could either
pick the points with the mouse or type the coordinates with the
keyboard.

2) Specify an XY Distance and Angle

If you already know the distance and angle that you want
the duplicates to be placed in relation to the originals, you
could enter that distance and angle in these fields.

3) Specify an X Distance and Y Distance

This is in case you know the distance in X and the distance
in Y but not the angle or the XY distance.

In the case of this particular example, we know the X
distance is 3.3 inches and the Y distance is zero, so we could
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enter an X distance of 3.3 and a Y distance of zero. We also
know that the XY distance is 3.3 and the angle is 0°. So we
could also enter 3.3 as the XY distance and specify an angle of
0°. We could also enter a From point of X0, Y0, and a To point
of X3.3, Y0. Or we could specify a From point of X5.5, Y6, and
a To point of X8.8, Y6. All of these methods give us the same
destination because they all give a distance of 3.3 in X and
zero in Y.

Notice the dotted line in Figure 1-28. This line shows you
the direction and angle that you are specifying. The start point
for this line has been arbitrarily chosen by MillWrite; it is
merely to show you the direction and angle that you are
placing the duplicates. If you had specified a From point then
MillWrite would draw this dotted line from that particular
point.

The Handle of the array

One the array data fields is called Handle. To understand
the purpose of the handle the drawing needs to be modified to
make it more complicated. Figure 1-29 shows the
modification. The switch that the array is created from is still
specified as being 0.7 inches below the top of the panel as
measured to its center. But now the three switches are
specified as being 1.9 inches below the top of the panel, as
measured to the center of the circle that each switch contains.
Previously all switches were measured from the top of the
panel to the center of the switch.

This inconsistency in measuring the positions of the
switches makes the array more difficult to create. Now you
don't know where the centers of the three switches are, nor do
you know the distance between the switch at the top and the
three at the bottom. If you knew the dimensions of a switch
you could figure out whatever you needed to know, but the
less figuring you do, the fewer mistakes you make. However,
the handle option allows you to create this array without doing
any calculations.

To create the array, you first select the initial switch (see
page 11 about selecting items), then click the Array button,
and then fill in the fields as seen in Figure 1-30. All fields get
the same values as before except for the Start Y coordinate,
which is now -1.9. MillWrite will then draw the three switches.

Notice the three dots in Figure 1-30. These identify the
array locations. MillWrite has centered each switch on one of
those array locations. But this time each switch needs to be
placed at its array location so that the center of its circle is at
one of the dots.

This is when you use the Handle option. The Handle tells
MillWrite where to pick up the object you are making an array
of. The handle is like the suction cup that you use to pick up a
glass window. To make this particular array, you want
MillWrite to pick up the initial switch at the center of its circle,
and then lay each copy onto one of the array locations at that
handle location. Therefore, the center of that circle will be the
handle.

If you knew the coordinates of the center of that circle, you
could type them into the handle data field. However, it is
easier to pick the point with the mouse, and you’re less likely
to make a mistake.

To pick a point in the drawing for the handle, first click on
the label Handle to let MillWrite know which field you are
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setting. The prompt at the bottom of the screen will change to
remind you to pick a point in the drawing with the mouse. You
can see this prompt in Figure 1-30.

Then move the mouse into the drawing and touch the
center of the circle, as seen in Figure 1-31. You will know when
you have touched the center when you see the mouse icon
change to show the words Arc Center. Then click the left
mouse button. The coordinates in the Handle field will change
to whatever they are at the center of that circle. Also, MillWrite
will update the positions of the three switches in the array so
that their handle is at an array point, as seen in Figure 1-31. The
array is now complete so press the OK button. (Remember to
un-check the Delete Originals box.)

You can also set the handle point with the Object Snap
functions. For example, you could set the handle to the
intersection of two lines in the drawing, or you could set it to
the midpoint of some line or arc, or you can set at to be a
certain distance and angle from some point in the drawing.

The CONTROL and ALT keys

When you press and hold either the x or m keys,
MillWrite will put a menu up along the bottom of the screen to
remind you of what CTRL or ALT commands are available. If
you press the x key when you are at the Drawing page, the
menu in the image in Figure 1-32 pops up.

The colored letters in the menu are the hotkeys. There are
some exceptions, such as the backspace key; the entire word
backspace is colored. Also, some words are colored but in a
different color than the hotkeys. These are messages to you
rather than hotkeys.

The x or m menus are different at the drawing page than
at the other pages. If you do not see a menu when you press
the x or m key, that means there are no x or m key
functions for whatever you are doing.

Some the CTRL key commands are:

Close job xd

This option doesn’t show in the menu because it is a
standard Microsoft Windows command, so it is assumed that
you already know it. The command closes the job file and starts
a new, empty drawing. You are prompted to save the existing
job, if it hasn’t been saved already.

Save job file xS

This will save the job file on disk.

Toggle zoom on Go to X-Y coordinate xG

This determines if MillWrite zooms in to show the location
you specify with the “Go to X-Y coordinate” function (page 6 ).
If not zooming, the “Go to X-Y coordinate” function merely
shifts the view.

Nudge hi-lited item xD xutv…

One of the messages in the x menu that doesn’t have a
colored hotkey is “Keyboard arrow keys: nudge hi-lited item
up/down/left/right”. This reminds you that when the mouse is
touching an item you can hold down the x key and then press
the arrow keys to move the item by whatever you set the nudge
distance to. If you set the nudge distance to .01, you can move
items in increments of .01. Of course, as soon as you nudge the
item into a different position, the mouse will not be touching it,
so don’t let go of the x key until you have the item in position.
Press xD to set the nudge distance.

Toggle boxes on/off xB

Text items have dotted boxes around them, which is what
you grab them by to move or modify them. But they clutter the
screen. To see the drawing more clearly, toggle the boxes on
and off with xB.
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